Movavi Video Editor Plus 2020
Don't know where to start?

Perhaps these tutorials would help:

Remove trial restrictions

Save your video without a watermark
and use the program after 7 days.

Make a quick video

Have your video ready in just 5 minutes
using the new Montage Wizard.

More questions?

Write us an e-mail at support@movavi.com

Make a video from scratch
Learn how to do basic
editing using the Timeline.
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Activating Video Editor

When you first start Movavi Video Editor Plus, it will be running in TRIAL MODE. To use the program without the trial restrictions, you will
need to buy the full version and activate Movavi Video Editor Plus. If you don't have the activation key yet, click the button below to visit the
site and purchase the key.

Activate the program

1. Launch the program.
2. Go to the Help menu and select Activate Software.
3. Copy the activation key from your e-mail and paste it in the activation window.
4. Click Activate.

Activating without Internet access

If the computer you have installed Movavi Video Editor Plus on is not connected to the Internet, you can activate the program via email.
See detailed instructions

If you haven't received your activation key within the hour:
• Check the Spam folder of your mailbox
• Contact support

I bought Movavi Video Editor Plus, but my videos already have a watermark

After you have activated the program, you can open the movie project and re-export the movie without the watermark.
How to export videos

Activating without Internet access
1. Click the button below to buy an activation key. After the purchase is completed, the key will be delivered to you via e-mail. If you already
have a key, skip to the next step.

2. Open the program and go to Help > Activate software
3. Enter your activation key and select the Activate offline option. Click Activate.

4. In the next window, click Copy and transfer this information to a computer or device with an Internet connection.

5. When you have access to the Internet, paste the information you copied into a new e-mail and send it to reg@movavi.com. You should
receive a reply within an hour. Copy the activation key from the reply and transfer it to the computer with Movavi Video Editor Plus.

6. Return to the window with offline activation. If you've closed the window, repeat steps 1-3 and enter the same activation key you used
before. Then, paste the registration key into the box and click Activate.

If the activation is not happening
• Make sure that you have used a correct activation key. There should not be any additional symbols or spaces after the last digit of the key.
• Also make sure that the key you're using is meant for the Movavi Video Editor Plus.
• Before attempting the activation, stop the antivirus software and the firewall of the computer.

• Check that your user account has the administrator rights.
• If nothing helps, email the support team.

Managing subscription

If your subscription has expired, you need to renew it to continue using the program.

To renew your subscription, click the Renew Subscription button. A web page will open, where you can buy the license. Once you've made a
purchase and received the activation key in an email, copy the key and paste it into the program window. Then click Activate.

Have troubles renewing the subscription?

• If you haven't received an e-mail with the activation key within an hour, check the Spam folder in your email box.
• Contact our support team. Our experts will help you figure out and solve any of the related problems.

Activating and installing packages

Expansion packages are sets of additional content, which include transitions, titles, stickers, backgrounds, and music. The packages help
you achieve your creative goals, broaden your freedom of expression, and save time choosing the right artistic tools.

Acquiring a package

1. Go to Movavi Effects Store. You can also find this this link in the Help menu > Movavi Effects Store. Or by clicking a cart icon in effect,
transition, title or sticker collections.
2. On Movavi Effects Store web-page choose and purchase the packages you like. After the purchase is processed you will receive an e-mail
with an activation key, a link to download the package, and an instruction on how to install it.

Installing a package

1. Click the link you received with the e-mail and download the package.
2. When the download is finished, open the package as you normally would open your project: double-click the file or drag and drop it in the
Video Editor. The program will run the installation process.
3. In the Installing Package window click Install and follow the instructions on the screen.

Activating a package

1. Copy the activation key from your email.
2. Paste it in the in the Activating Package window.
3. Click Activate.

Wait until the installation is finished. The new elements will appear in the corresponding categories. The categories with the new elements
will have a yellow dot on them and the elements will be marked with the NEW label.

Cannot install or activate the package? Make sure that:

• The Video Editor you have installed on your system supports the packages;
• You use the key that was sent to you after the purchase of a package and there are no additional symbols after the key;
• You have enough free disk space to install the package.

Quick Start

In this mode you can use all the tools that the Video Editor has to offer and create professional-looking videos without complicated software.
You can create a new video by creating a new project or a quick video.
1. To start creating a project just add files on the Timeline. If you want to start another project select Create New Project in the File menu.

2. Click Add Files or drag and drop your files over the import area to start working on them.

3. Change the clip layout on the Timeline, crop images, cut videos, using the toolbar.

4. Add effects, transitions, titles, and more by changing the tabs on the left-hand side of the screen.

5. To add filters and transitions to the project, drag them to the Timeline.

6. Save your video:

1) Click the Export button.
2) Choose file format.
3) Name the video, select a folder to save the video to and set the quality.
4) Click Start and wait until the processing is finished.

Make sure to save your work once in a while: choose Save from the File menu to save the project so that you can access it later.

Quick Video mode

You can use the Montage Wizard to automatically build a video for you in minutes. All you need to do is provide the Wizard with some video
clips or photos, choose a music track, and let the Wizard cut and build the video for you. You can also use the Montage Wizard to make
slideshows.
1. Click Quick Video to open the Wizard.

2. On the Files tab, click
or drag and drop your files over the window. To remove files, click the
hand corner of each file, or select the files you want to delete and click Delete Selected on the bottom panel.

in the upper right-

3. Switch to the Templates tab or click Next.
4. Choose a theme or a transition template.
No transitions template does not add any transitions to your video, but your pictures will still have a Pan and Zoom effect applied by
default.
Transitions template puts some kind of smooth transitions between the slides.
Theme template uses the sample music tracks, a set of different transitions for each of the themes and various title styles.

5. Switch to the Music tab or click Next.
6. Add music. Choose from the built-in tracks* or add music of your own. You can also add more than one track.

*The audio tracks are royalty-free so you can upload these videos to YouTube and other services.

7. Switch to the Preview tab or click Next.
8. Customize the opening and ending titles, change text and click Apply.

9. Under the Advanced tab make other necessary changes.
• Video duration
You can set your video to be the same length as the audio by selecting the Fit to music length option or use the slider to set how long you
want the video to be. If you opt for a shorter video, some clips may not appear in the end result.
• Fill black bars
If the resolution of the project and the files you've added to the video are different, black bars will appear. You can remove them by
checking the Fit to frame option – the image resolution will be automatically fitted to the frame size.
Learn more about frame size
• Volume balance
By bringing the upper slider to the right end you will turn the volume of the added video up to maximum. And by bringing the bottom slider
to the right end, the volume of the background audio track will have its maximum volume.
• Arranging clips
If you have a lot of pictures and want to change their order in the video, click the Shuffle button. The Wizard automatically mixes your files
and puts them in a different order.

Tip: You can also set a desired order of appearance of your files by returning to the Files tab and dragging the file icons in a desired order.
10. Watch the finished video in the player on the Preview tab and switch to the Export tab.
11. Select what you want to do next with your video:
• Save the video – save the video to your disk.
• Continue editing – add final touches to your video by adding effects, more titles, animation and more.
• Upload online – save the video to your disk and upload it to YouTube, Vimeo, Google Drive or Movavi Cloud.
12. To save the video, choose a video format and pick a folder to save the video file.
If you're uploading the video to YouTube, sign in with your YouTube account and fill in the details about your video. Then click Start to
begin saving the video.

Learn more:

Adding filters
Adding titles
Color adjustments
Removing black bars

Adding media

To begin working on your video project, you first need to add some media files. Use your own files or any of the built-in media.

Add your files

1. On the File import tab click Add Files.
2. Select the files and click Open. They will appear on the Media bin tab.
3. From the Media Bin tab drag and drop the files onto the Timeline. You can remove the selection of all files by clicking on an empty space
within the bin area, or by selecting a single file.

Add built-in media

1. On the Import tab select the type of media you want: sounds, music, sample video or backgrounds.
2. Switch to a tab.
3. Click the file icon to download and see it or to listen to it.
4. Choose a media file and drag it onto the Timeline to add to the project.

Arrange the files

Once you've added the files, they will appear on the Timeline at the bottom of the window. The Timeline allows you to arrange the clips in the
order you want. To reorder the clips, select the clips you want to move and drag them to the new position.

See also:
Working with video
Working with audio

Recording video

1. Connect the camera you want to capture from to the computer. Make sure that the system recognizes the device and that it is working
correctly.
2. On the Import tab of the Video Editor Plus, click Record Video. The recording module will open in a separate window.

3. In the Video capture device box, choose the camera.
4. Then, select the resolution and frame rate. A larger resolution will be able to retain better quality, however, the video file size will be larger.
A higher frame rate is necessary for recording motion, while static scenes can be captured with a lower frame rate.
5. In the Audio capture device box, choose the microphone.

6. Choose a destination folder. By default, the recordings will be saved to your Movavi Library folder. To change it, click the icon
Save files to box.

near the

7. Click Start Capture to begin recording the video. During capture, you can take snapshots using the camera icon
on the right.
8. When you're done, click Back to editing at the bottom of the window. The captured files will be added to the Timeline and saved to disk.

Creating an intro
Intro videos are specifically designed short video clips that use visual elements and text and can be edited or customized. If you don't know
where to start in making a unique intro, you can use the ones that are already made and pre-installed into the program. You will only need to
change the text.

Create a new intro

1. In the Titles collection go to Intro videos.
2. Find the New intro clip and drag and drop it onto the Timeline.

Edit the intro
1. Click
on the clip and the Timeline will switch to the intro editing mode.
2. Add your own media files (video, audio or pictures), effects, titles and other. Work as if you're working with a usual project, but keep in
mind that your making a special introductory video.

*Before you start editing, delete the instruction clip that the new intro contains.

Save changes
Click

on the toolbar to save changes and go back to the main editing mode.

To save the intro and use it in other projects, select the intro clip and click
You can edit the intro at any time while working on the project.

. The intro will be saved with all the other items in the collection.

Managing projects

A project keeps all the work on your video or slideshow. You can save the project to finish your work later, or restore your work if you need to
edit something after you've finished. A new project is created automatically when you start working on a video.

Creating a new project

1. On launching the Video Editor you can start making a video right away.
2. To start a new project while working on another project, go to the File menu and select Create New Project or Create Quick Video.

Saving projects

1. Go to the File menu and select Save Project. Or use a keyboard shortcut Ctrl+S.
2. Name your project. All projects are stored in the "\My Videos\Movavi Video Editor\Projects" folder of your user.
3. Click Save.
You can later open the project file and continue working on it. To avoid losing your editing progress, make sure to save your project every
once in a while. To save a project, open the File menu and select Save Project.

After that, you can save your project as a file in the *.mepx format on your computer and open it later to continue editing your movie.

Viewing videos

Project files cannot be viewed in a regular video player, and can only be opened with Movavi Video Editor. To view the final video in a player,
you need to first export your project to a common video format.
Learn how to export your project

Opening projects

1. Open the File menu and select Open Project.
2. Find the project file, select it and click Open.
You can also open projects in several different ways:
A. Find your project in Windows Explorer and drag it onto the Video Editor window or double-click it.
B. In the Import area click Add Files and select find your project.

Restoring a project from an autosave

If your computer malfunctions and you cannot save the project, some of your work may be restored using an autosave file. Rename the
"autosave.mepx" file and open it in the Video Editor to continue working on your project.

Restoring media files

When you open a recent project, you may see a message saying that a file is missing from the project. This may happen if one of the files
used in the project has been moved somewhere else or deleted from disk. In this case, click Specify Folder in the message box to find the
files in their new location, or click Skip to open the project without the missing files. You can also click the magnifying glass icon
specify location of a single file. We recommend to copy all the files to your hard drive before editing.

and

Transferring projects
Saving portable project

A portable project is a kind of project that contains all the media files that comprise it. Since the program does not create copies of the files
and only refers to their location on the disk, the project will only work properly on another computer if all the media files are present there as
well. With the portable project saving option, you don't have to collect all the files manually.
1. Open the File menu and choose Save Portable Project
2. Set a path for your project folder to be saved to and click Save.
3. Then transfer the project folder to another computer with Movavi Video Editor installed.

Read more:
Restoring lost files

Appending a project
If you work on a big project, you might want to separate it into several smaller ones for a more convenient editing process. Then, to combine
them back together, append other projects to the major one.
1. Open a project or create a new one.
2. Open the File menu and click Append Project.
3. In a new window, find and open the project you want to combine with your current project. The project you append will be added at the end
of all other clips in the current project.

Preview and organize clips
Use the player in the upper right-hand part of the window to preview your project.

Current position

Your current playback position can be controlled using the position marker under the player and on the Timeline.

For precise positioning:
• To move in 0.5 second increments, open the Playback menu and choose Skip Forward by 0.5 Seconds (Ctrl+Shift+→) or Skip Backward by
0.5 Seconds (Ctrl+Shift+→).
• To move precisely from frame to frame, use the Previous frame (Ctrl+→) and Next frame (Ctrl+→) buttons in the player.
• To switch between clips, use the Previous clip (Shift+→) and Next frame (Shift+→) buttons in the player. This will move the position marker
exactly one frame backward or forward.
• Use the Scale slider to zoom in on the Timeline to make positioning easier.

Playing the video

1. Move the position marker to where you want to start playback.
2. Click Play or press the Space Bar key.
3. Click the Pause button or press the Space Bar again to pause playback.

1 – player position marker
2 – current time
3 – previous clip
4 – previous frame
5 – play/pause
6 – next frame

7 – next clip
8 – aspect ratio of the project
9 – player volume
10 – snapshot of the player
11 – additional settings of the player

Arranging clips

By default, media files will appear on the Timeline in the same order in which you've added them. To rearrange the clips, drag them with your
mouse and drop them onto the desired position. To select multiple clips, use Ctrl+click or click and drag to draw a selection on the Timeline.

Edit and enhance clips
Arrange, edit and enhance clips with the tools that you can find on the toolbar and on the More tab.

In a table below see what tools you can use on clips and how to apply them.
Split

Set the position marker on the Timeline where you want to separate your clip and cut it.

Rotate
Crop

Turn the clip clockwise.
Set on the player the space you want to keep and cut the borders.

Adjust color
Turn the sound up or down

Make the necessary color changes using presets or set them manually.
Click Clip properties and use the Volume slide to change audio loudness.

Normalize the video sound
Change video speed
Reverse the video

Select the Normalize checkbox in the Clip properties to make the sound smoother.
Click Clip properties and use the Speed slide to make the video faster.
Select the Reverse checkbox in the Clip properties to play the clip from the end to the
start.
Move the Opacity slide to make the clip transparent.
To change the clip length move the borders of the clip on the Timeline or use the Speed
slide to make the clip faster.
Use the Fade in and Fade out slides to make the clip appear and disappear smoothly.

Change opacity
Change clip length
Make clip fade in or out

Edit videos and images

Photos and videos aren't always perfect from the beginning. Use the buttons on the toolbar to fix and adjust the clips.

Picture in picture and overlays

To overlay one video or image on top of another, select the clip you want to show on top and drag it up, towards the top of the Timeline to
create an extra overlay track. Then, double-click the upper clip to set up where the overlay will be shown on the video.
Learn more about overlays

Picture and picture, side by side overlay modes.

Rotating videos and images
Nobody likes vertical videos! But don't worry, in just a few clicks, you can turn any photo or video around without having to crane your neck.

Rotating by 90 degrees

1. Select the clip you want to rotate
2. Click the Rotate button on the toolbar to rotate the clip by 90 degrees clockwise. Click the button again to rotate the video more.
Learn more: Removing black bars

Fixing the horizon level

1. Select the clip on the Timeline.
2. Click the Crop button on the toolbar.
3. Use the Angle slider to slightly rotate the clip inside the frame, until the horizon is level with the guides in the player.

Cutting clips
Use the scissors button on the toolbar to cut video and audio clips into parts. To delete a clip you don't need, click the trash can button.

Splitting clips into parts

1. Select the clip that you want to split.
2. Move the position marker to the moment where you want to cut the clip.
3. Click the Split button on the toolbar.

Cutting out fragments

How does the cut clip look like.

Cut the clip at the beginning of the unwanted fragment
1. Select the clip you want to cut.
2. Move the position marker to the beginning of the fragment. Use the Previous Frame and Next Frame buttons on the player to catch
the moment precisely.
3. Click the Split button. The clip will be cut into two parts, with the unwanted fragment at the beginning of the second clip.
Cut the clip at the end of the fragment
1. Select the second clip the you've just cut off.
2. Move the position marker to the end of the fragment.
3. Click the Split button again. The fragment should now be in a separate clip.
Delete the unwanted fragment
1. Select the clip with the unwanted fragment.
2. Click the trash can button or press the Delete key to remove this clip. The clip will be removed, and the remaining clips on the
Timeline will move to close the gap.

Trimming clips

If you only need to cut off some parts at the beginning or at the end of a video or audio clip:
1. Place your mouse pointer over the edge of the clip.
2. Click and drag the edge towards the center of the clip to trim the clip to the desired length.

For more precise navigation:

• Open the Playback menu and use the Skip Forward by 0.5 Seconds or Skip Backward by 0.5 Seconds commands to jump half a second
forward or back.
• Use the keyboard shortcuts to move the position marker half a second back and half a second forward, respectively: Ctrl+Shift+→ and Ctrl
+Shift+→.
• Use the Previous Frame and Next Frame buttons for precise frame-by-frame navigation. You can also use the Ctrl+→ and Ctrl+→ keyboard
shortcuts.

• Use the Previous Clip and Next Clip to switch between the clips in the player. You can also use the Shift+→ and Shift+→ keyboard shortcuts.

Cropping
Cropping a video can help you remove black bars, cut away the edges of the video, or permanently zoom in onto an object inside the frame.
1. Select the clip on the Timeline.
2. Click the Crop button on the toolbar to open the Crop tool, and a cropping frame will appear inside the player.

3. In the player, set the frame so that the parts you want to cut are outside it. Drag by the corners of the frame to change its size, and drag by
the center of the frame to move it.

Use the Angle slider in the Crop and Rotate section on the left to rotate the crop frame.

4. Click Apply. A star

icon will appear on the clip once you've applied cropping.

Removing crop

1. Click the star icon on the clip to show the list of applied effects and filters:

2. A tab will open above the toolbar. Find the Crop effect and click the cross button

next to it to discard the effect.

Color adjustments
Change color settings

1. On the Timeline, select the clip that you want to adjust.
2. On the toolbar, click the color adjustments button to open the adjustments tool.

3. Select Easy mode to use color presets for quick and simple adjustment.

Or select Advanced mode to set your own settings.

If made your own adjustments to the image and want to save them for future use, click Save Adjustments and name your preset. The
new preset will appear on the Auto Adjustments tab.

Once you have used the adjustments, the clip will be marked with a star icon, denoting applied tools or filters:

Video speed

Speed up or slow down a video or audio clip with the Speed slide. This can be useful if you're working on a music video and you want the
video to match the tempo of the music.
1. On the Timeline, select the clip you want to edit.
You can also change the speed of any audio clip. If you modify the speed of a video with built-in audio, the audio speed will also be
changed.
2. Click the Clip Properties button to open the editing tools for the selected clip.

3. Drag the Speed slider to set the necessary video speed.

The clip's length on the Timeline will change to reflect the new speed. If you've changed video speed, the video clips will be marked with
a star icon:

Reversing video
Reversing the video will play the clip and its audio backwards. You can combine reversing the video with increasing speed and the VHS filter
to create a cool rewinding effect.
1. On the Timeline, select the clip that you want to reverse. You can reverse both video and audio clips.
2. On the toolbar, click the Clip Properties button to open the properties for the selected clip.

3. In clip properties, select the Reverse option.

When you apply reverse, the clip will appear with a reverse icon on top of it:

Image duration
You can change how long each image appears in your video or slideshow either using the clip properties or you can set all images to the
same length.

Changing one image's length

1. On the Timeline, select the image clip that you want to edit.

2. Click the Clip Properties button to open the properties for the selected clip.

3. In the Duration box, enter the new length of the image. Use the following format: hours: minutes:seconds.milliseconds. Changes will be
applied instantly.

You can also change image duration by selecting an image clip on the Timeline and dragging its borders left or right. The longer the clip
appears on the Timeline, the longer it will play in your movie or slideshow.

Setting the same length for all images

To set all of the project's images to the same length:
1. Click the Transition Wizard button on the toolbar.
2. In the Transition Wizard window, enter the preferred length into the Image slide duration box. If you don't want to use transitions to join
your clips, select No transitions in the box at the top.
3. Click OK to set all the images to the selected length.

Fading video

In the editing tools, you can add smooth fades to the beginning or the end of a clip. For videos and images, you can use fading
simultaneously with animated transitions. For audio clips, you can create a smooth crossfade effect between songs.
1. On the Timeline, select the clip that you want to fade.
2. Click the Clip Properties button on the toolbar. The clip properties will open in the Tools panel above.

3. Set the fade length using the sliders on the Video tab.
Fade in – how long in seconds it will take to fade in to full opacity at the beginning of the clip.
Fade out – how long in seconds it will take to fade out from full opacity at the end of the clip.

See also:
Adding transitions
Fading audio

Creating overlays

Overlays are video or image clips that are shown over the main video. You can use these to create a split screen or picture in picture effect,
add a logo or watermark, create a Chroma Key effect, or insert a short clip without cutting the main video.
1. Add files to the project: a background video and a foreground video or a photo.
2. Select a clip which should go on the overlay track and drag it above the main video track.

3. Place the clip on the overlay track at the right time on the needed position. You will see a line connecting the clip on the overlay track to the
clip on the video track. When you move, cut, or delete a clip on the video track, the overlay clip will be affected as well. When you move the

clip on the overlay track, an editing panel will open. If you switch to a different tool, you can go back to this panel by clicking More Tools —
Video Editing — Overlay.

4. On the tool panel select overlay mode: Picture in picture, Logo, Overlap, Side by side or Trio.

Picture in picture mode

This is the default overlay mode. Using picture in picture mode, you can place the overlay video over any part of the screen.
1. Choose Picture in picture mode.
2. In the player, move the overlay clip to where you want it to appear in the frame.
3. To resize the overlay, drag at its corners. Clip's aspect ration will remain the same.

Logo mode

1. Select Logo mode to place the overlay clip at the upper right corner and use it as a logotype.
2. Drag and move the logo to any part of the frame.

Side by side mode

This mode splits the frame into two parts.
1. Select a clip on the overlay track and then choose a side by side mode.
2. Hover the cursor over the selected clip in the player. Move the image in the frame, and zoom in or out on it with the scroll wheel.

Trio mode

With this mode you can have up to 3 videos in a single frame.
1. Select a clip on the overlay track and then choose a side by side mode.
2. Hover the cursor over the selected clip in the player. Move the image in the frame, and zoom in or out on it with the scroll wheel.
3. To add another video and get three in a single frame, add one more clip to the overlay track and repeat steps 1 and 2 for it.

Overlap mode

In Overlap mode, the video on the overlay track will cover the main video completely. You can use this mode to avoid cutting the main video,
and showing another clip instead, or to create a Chroma key effect.

How to change background (Chroma key)

Adding a watermark

Adding a watermark to your videos will protect your ownership even if it's shared all over the Internet. You can add an image overlay with
your own watermark or logo, or make a new one using text.

Image watermark

1. On the Import tab, click Add Files and add the image or video that you want to use as the watermark. For the best look, use images with
transparent areas.
2. Drag the watermark clip up to the overlay track to make it appear on top of other videos.

3. Double-click the watermark clip to edit the overlay, which you can move and resize in the player.
4. To change the opacity or duration of the watermark, click the Clip Properties button.
5. To set the opacity use Opacity slide in the properties. To make the watermark show over the whole length of the video, enter your project
length into the Duration box, or drag the right edge of the overlay clip until the end of the video track.

Text watermark

1. Click the Titles button on the left and pick a nice title style for your watermark.
2. Drag the titles you like onto the beginning of the Titles track at the top of the Timeline.

3. Double-click the titles and enter your watermark text. Pick a cool font and color on the panel above the player. Click Apply when you're
done.
4. To make the watermark show over the whole length of the video, drag the right edge of the text clip until the end of the video track.
If your movie is long, zoom out on the Timeline to make changing clip length easier.
OR: Double-click the text clip to enter text editing mode and enter the length into the Duration field. You can find the length of your whole
project at the bottom of the window.

Creating a freeze frame
A freeze frame is a single frame of a video that repeats for some time, creating an illusion of pausing the video. You can use freeze frames to
emphasize a moment or create a pause to explain things to the viewer.

1. Move the position marker over the frame of the video that you want to freeze. To skip by precisely one frame at a time, use the Previous
frame and Next frame buttons under the player.

2. Once you're on the right frame, open the Edit menu or right-click on the clip and choose Insert Freeze Frame from the menu.

3. By default, a new freeze frame is four seconds long. To change the duration, drag the edges of the clip to make the clip shorter or longer.

Learn about changing image duration

Removing black bars

Sometimes, when you use videos of different aspect ratios, or if the project is set up incorrectly, some videos may have black bars around
them. You can remove black bars from videos using one of the ways below.

Use filter

1. On the Timeline, select the clip with black bars around it.
2. Click the Filters button on the left sidebar to open the Filters tab.
3. Find the Vertical fill filter in the Adjustments group and drag it onto the clip.
Learn more about filters

Manual crop

If black bars appear only on one or several clips, you can cut off the edges to make the video fit better inside the frame.
1. On the Timeline, select the clip with black bars around it.
2. On the toolbar, click the Crop button.
3. A frame will appear in the player. Set this frame on the part of the video that you want to keep. Parts that are outside the frame will be cut
off.
4. In the Tools tab on the left, click Apply to accept the changes.
Learn more about crop

Fading effects
Make effects and filters fade in using the overlay track.
1. Copy the clip and paste it onto the Timeline.
2. Drag the copy of the clip on the track right above the original. Now you have two identical clips right on top of each other.

3. Double-click the clip on the overlay track and choose Overlap mode in the panel above the player.

4. Apply the effects or filters you want to use onto the upper, visible clip.
Learn more: Applying filters

5. With the overlay clip selected, click the Clip Properties button and select General settings. There, use the Fade in and Fade out sliders to
set the fading time. Here you can also set Opacity if you want to reduce the effect's strength for the whole clip.

The clip with the effect will gradually appear and disappear, exposing the underlying original clip.

Adding and editing audio

Add an audio

1. To add music or other sounds to your project, open the Import tab.
2. Select File import category.
3. Click Add Files or just drag your files on the panel.
Also you can use one of the built-in music or sound tracks:
1. Click the Music or Sound category and take your pick from our royalty-free music collection.
2. Drag the tracks you liked on the Timeline.

Edit an audio

To edit the audio file, double-click the audio track, the settings panel will appear.

Volume
Normalize
Speed
Fade in
Fade out
Reverse

How to record an audio

Sets the volume of the clip.
Makes quiet parts louder.
Makes the audio play faster or slower.
The audio goes from complete silence to full volume in the time you set.
The audio goes from full volume to complete silence in the time you set.
Plays the audio backwards.

Recording audio

1. Connect a microphone to your computer.
2. On the Timeline, place the position marker to where you want the recording to start.
3. Click the microphone button on the Import panel to open recording options.

4. Set up your recording device and volume.
5. Click Start Recording and record the audio.

6. When you're finished, click Stop Recording. You'll find the recording on the Timeline.

Set start time for audio clips

After you've added the audio files, they will appear on the audio track of the Timeline as green clips. To change when the audio clip starts
playing, drag it along the Timeline, using the ruler at the top for time reference.

Extracting audio from videos
If you want to use a sound track from a movie, you can extract it from a video file and use it in your project.
On the Import tab, click Add Files and choose the video or just drag a video on the panel. The file will be added to the video track on the
Timeline.

How to trim the parts of the video if you don't need to extract the whole audio track:
1. Move the position marker to the beginning of the fragment you want to keep and click the Scissors button on the toolbar. This way you will
cut off the beginning of the video.
2. Now, move the position marker to the end of the fragment you need. Click the Scissors button again, and the fragment will now be in a
separate clip. 3. If you don't need the other fragments, select them on the Timeline and click the trash can button on the toolbar to delete them.

3. The audio that belongs to a video is shown right underneath it on the video track. To separate it from the video, drag the audio stripe down
onto the audio track. If you don't need the video clip anymore, just delete it.

You can now work with the extracted audio clip separately.
If you want to save the audio clip for later use, you can export it as an audio file:
1. Click the Export button at the top of the program.
2. In the Export window, switch to the Save Audio File tab.
3. Select an audio format.
4. In the Save to field you will see where on the disk the file will be saved by default. To change that folder, click Browse and select a new
folder.
5. Finally, click Start to save the audio file.

Please respect copyright laws and stay within the boundaries of fair use of copyrighted materials.

Looping audio

If the music file is shorter than your video, you can loop the audio and have the file play over again until the end of the video.
1. To copy the audio clip, right-click the audio clip on the Timeline, and choose Copy from the pop-up menu.
2. Paste the audio clip onto the Timeline right next to the first clip. The clip will be inserted right after the position marker. Repeat until the
audio length is greater or equal to the video length.
3. Now, the audio track may be longer than the video track. To trim the audio, hold your mouse pointer over the right edge of the clip, and
drag it to the left.

Volume curves
Volume curves allow to control the volume for each part of the clip and smoothly increase or decrease the volume.

Each clip has its own volume curve that starts out at 100% volume for the entire clip, and two points at its beginning and at the end. The white
line on the image below is the volume curve before you add any points.

Set the volume level

1. Drag the white line up or down to the necessary level. The top of the clip is 100% volume and the middle of the clip is 50%.

2. Points on the audio curve represent the volume peaks and lows. To add a point, right-click on the audio curve and choose Add Volume
Point from the pop-up menu.
3. Drag the audio point to the necessary volume level. You'll notice that the surrounding parts also move with the point to make the transition
smoother.
4. Make as many points as you need for each part of the clip where you'd like a peak or a drop in volume.

5. To set the volume level for a part of the clip, you'll need at least two points. Create a point at the beginning and at the end of the fragment:

6. Create as many volume points as you wish to make a necessary effect.

Linking audio

To make audio clips to stay in sync with videos or images as you edit your project, link it to each other.

To link an audio

1. Select an audio clip on the audio track at the bottom of the Timeline.
2. Drag the track under the video clip you want it to link to.
3. On the left side of the Timeline click the Link button to create the connection between audio and video clips.

Fading audio
In the editing tools, you can add smooth fades to the beginning or the end of a clip and create a crossfade effect between audio tracks.
Fade in – how long in seconds it will take to go from silence to full volume at the beginning of the clip.
Fade out – how long in seconds it will take to go from full volume to silence at the end of the clip.

Set up the fading effect

1. Select the clip on the Timeline.
2. Click the Audio Properties button on the toolbar.
3. Set the fade length using the sliders on the Clip Properties panel.

Equalizer
Using the equalizer, you can boost or reduce the levels of specific frequencies.

Set the equalizer

1. Select the audio clip that you want to edit. This can also be a built-in audio clip on the video track.
2. Click More on the left sidebar and find Audio Editing to open Equalizer.

3. Choose an equalizer preset to set the effect quickly. If you want to set more advanced configuration drag the volume bars to adjust the
frequencies to the necessary level.

4. To save your own equalizer presets for their further use, click the Save button. In the new window enter a preset name and click OK. The
created preset will appear in the presets list.

Noise removal

1. Select the audio clip that you want to edit. This can also be a built-in audio clip on the video track.
2. Click More on the left sidebar and find Audio Editing to open Noise Removal.

3. Use the Noise suppression slider to set the amount of noise you want to remove.
Don't set the noise suppression too high if there isn't much noise because it can start muting other sounds.

Audio effects
Audio effects can transform the sound of an audio clip.
1. Select the audio clip that you want to edit. This can also be a built-in audio clip on the video track.
2. Click More on the left sidebar and find Audio Editing to open Audio Effects.

3. Click the box in the Audio Effects section and choose an audio effect you like.

Removing effects

When you've applied an audio effect to a clip, a star icon will appear on it:

Click on the star to see a list of applied effects. Then, select the effect you don't want and click the cross button

to discard the effect.

Beat detection
To make your video more dynamic, use the Beat Detection audio tool to automatically mark audio beats on the Timeline and then adjust your
video to the beat of the music.
1. On the Timeline, select the music that you want to detect beats for.
2. Click More on the left sidebar and find Audio Editing to open Beat Detection.

3. In the Beat Detection tool, click Detect Audio Beats. The program will analyze the music and place beat markers on the Timeline.

After the beat markers have been placed, you can modify their tempo. Use the Min time between beat markers slider to make the beat
slower or faster.

4. Adjust your clips to the beat. When you trim or drag clips, they will now snap to the beat markers, making it easy to keep to the beat.

Removing beat markers

1. To remove beat markers for a specific audio clip, right-click the clip on the Timeline and select Remove Beats from the pop-up menu.
2. To remove all beat markers from your project, right-click the Timeline ruler and select Remove All Beats from the pop-up menu.

Effect packages collection

Adding an effect package

1. Select the Effect packages section on the Import tab to open the list of packages.

The Available tab contains packages that you can purchase and use in the program.
In the Installed tab, you can find packages that you have already purchased and installed in the program.
2. Click on the package to purchase it.
3. Check the contents of the shopping cart and make a payment on the page.

4. Copy the activation key, which you receive on your email. To open the activation window, click on the key icon on the package.

5. Enter the activation key in the window that opens. To activate the package, click Activate.

6. After activation of the package it's necessary to download and install it. The key icon will change to the download icon on the image of the
activated package. To start downloading and installing, click on the activated package.

7. Click on the package to start the process of downloading. The package will be automatically installed in the program after downloading.

8. You will find all new uploaded content in the tabs marked with a yellow circle.

Viewing and deleting installed package

1. To view the installed packages, select the Installed tab.
2. To delete a package, click on the cross icon in the upper-right corner of the package image.

Filters
Add filters

1. Click the Filters button.
2. Choose All to see every filter in the collection or choose the specific category you need. To see the filter’s preview in the player, click on it.
To find a specific filter, enter its name into the search box above the filters. Click the heart icon to add the filter you liked to the Favorites
group.

3. To add a filter, drag it onto the clip you want to apply the filter to.
You can apply a filter to several clips at once. Hold the Ctrl key, select the clips on the Timeline and drag a filter onto any of the selected
clips. The filter will be applied to all the clips you've selected.

Once you've applied a filter, a star icon will appear on the clip, indicating applied filters and tools.

Clip with an applied filter

Remove filters

1. To see the list of applied filters and tools, click on the star
2. In the list, find the filter that you want to remove.
3. Click the cross button

icon on the clip.

to discard the effect.

Transitions

Transitions are short animations that use geometric shapes and transparency to connect two clips.

Add a transition

1. Click the Transitions button on the left sidebar to open the list of all transitions. Click on a transition to preview it in the player.
2. Pick a style you like and drop it between two clips on the Timeline. Click the heart icon

to add it to your favorites list if you like it.

A transition icon will appear between the two clips.

Change transition length

1. Double-click a transition on the Timeline to open transition properties.
2. Enter the new transition length in the Duration field. By default, each transition will be set at 2 seconds long. The format is
seconds:milliseconds. If you want all transitions that are currently in the project to have the same length, select the Apply to all transitions
option.
3. Click OK to apply the changes.

There are more options to fill the transitions with, such as:
Trimmed content

If you've trimmed the video, the trimmed bits will appear during the transition. If the
videos haven't been trimmed, a freeze frame is shown.

Freeze frame
Slow motion

A static frame is shown during the transition.
The part of the video overlapped by the transition is stretched to fill the entire duration.

Remove a transition

1. Right-click the transition on the Timeline and select Remove Transition from the pop-up menu.
2. If you want to delete all the transitions in your project, choose Remove All Transitions.

Titles
Add text to your video

1. Click the Titles button on the left side of the window to view the titles collection.
2. Click on a title style to preview it in the player and choose the titles you want to use. To add titles to your favorites, click the heart icon
.
3. Pick a title style and drag it onto the title track of the Timeline. Put it right above the video track, onto the time where you want them to
appear. You can link titles to the clip by clicking the link button
separate the titles from the clip with the help of the same button.

on the left side of the title track, the titles will move with the clip. You can

Edit titles

To change the titles, double-click the title's clip on the Timeline. The setting panel will appear.

Text
Clip
New Preset
Color

You can choose the title style and add the outline by selecting this option.
Change the duration and animation speed of the title.
Create a new preset with your personal settings and save it for further use. Your title will appear
in the My titles collection.
Choose an object on the player and change its color.

Timer
Add a timer

1. Click the Titles button on the left sidebar to open the list of available text styles.
2. Find the "Timer" title style. Use the search bar or click the Basic group to filter the styles.
3. Drag the Timer titles onto the title track of the Timeline. To change the length of the timer, drag the edges of the clip.

Edit the timer

To open the timer settings, double-click the timer clip on the Timeline.
Text
Clip
New Preset
Timer

You can choose the Timer style, add the outline by ticking this option, and change the color
of the background.
Change the duration of the Timer.
Create a new preset with your personal settings and save it for further use. Your Timer will
appear in the My titles collection.
Select the format of the Timer or add the countdown on the video.

Saving custom titles
After you've set up titles to look the way you want, you can save that style and use it in your projects:
1. Just like you usually edit titles, double-click the title clip and choose the font, color, and other options.
2. Click the Save icon at the top of the title editing panel on top of the player.
3. Enter a name for your titles and click Save.
The new title style will appear under the My titles group.

Stickers
Add stickers

1. Click the Stickers button on the sidebar to open the list of stickers.
Click a sticker to preview it in the player. If you liked a sticker, click the heart icon
to add the sticker to your favorites list.
2. Select the sticker and drag it onto the title track of the Timeline. All titles, callouts, and stickers go on the title track. Change the length of
the sticker to make it fit the clip.

Edit the sticker

1. Double-click to open the sticker settings.
2. Select the duration of your sticker.
3. Click Apply to save the changes.

4. To change the sticker's position on your video, double-click the sticker clip. In the player, drag the corner of the frame around the sticker
to change its size, and drag the center of the frame to move the sticker. To rotate the sticker, click and drag the white dot at the top of the
frame.
5. Click Apply when you're finished.

Transitions cannot be applied to stickers, but you can animate them.
Learn more: Animation

Animation

You can move objects any way you want and make creative appearances.

Add animation

1. Add the background onto the main video track.
2. Add the object you want to animate.

3. Click More and in the Video Editing choose Animation.

4. Select Easy mode to add quick and simple animation. To use the preset, just drag it on the clip.
To create your own unique animation, select Advancedmode.

Advanced mode

1. Select the clip you want to animate and place the position marker where you want your animation to be started.
2. In the Animation panel, click Add Animation.

3. In the player, you will see a frame appear around the object. Use it to set the position of the object.
On the Timeline, two points will appear on the clip. They are called keyframes. The first point is the original position of the object. The
second point will be its end position after the animation. The distance between the two points determines the animation speed.

Edit the keyframes

On the Timeline, double-click a keyframe to edit it. Adjust the animation:
Move the object on the player
Change the size
Rotate the object
Make it spin
Make the object fade in or out
Change the speed of your animation

Use the frame of the object
Drag the corners of the frame
Drag the white dot at the top of the frame
Use the Angle box on the Animation panel
Use the Opacity slider on the Animation panel
Move the keyframe point on the clip:
• Move the points closer together to make the animation go faster.
• Move the points farther away from each other to make it go slower.

To add another keyframe, move the position marker to where you want to place it in the clip and click Add Keyframe on the Animation panel.

Reset a keyframe

To make a keyframe go back to its original position, right-click the keyframe point on the clip and select Reset Keyframe in the pop-up menu.

Remove keyframes

1. To remove one keyframe, right-click the keyframe point on the clip and select Remove Keyframe in the pop-up menu.
2. To remove all keyframes and delete the animation, right-click any of the keyframe points and select Remove All Keyframes.

Not available in Video Editor Academic Edition.

Pan and zoom

You can control the camera movement using two keyframes and smoothly move from one frame to another.

Add the Pan and Zoom tool

1. On the Timeline, select the clip that you want to zoom.
2. To open the Pan and Zoom, select More on the left sidebar and find the Pan and Zoom tool in the Video Editing.

3. Select one of the presets and click it to apply.
This will add two keyframes to the clip. The camera will move between these two keyframes and you can set up camera movements from
one point to another.

4. To change the beginning keyframe, double-click the first point on the clip. Then, use the frame in the player to set the zoom level for the
starting point of the camera movement.
5. To change the ending keyframe, double-click the second point on the clip. Then, use the frame in the player to set the zoom level for the
ending point of the camera movement.

To change the length of the zoom effect, move a keyframe left or right. To move the zooming effect on the clip without changing its length
or other settings, move it along the clip.
If you want to add more camera movements, repeat steps 2-4 to combine other camera movements in one clip. For example, you can
zoom in on an object, pan across the frame with the same zoom level, and then zoom back out to 100%.

Add the Pan and Zoom effect to all the image clips automatically
1. Select necessary images on the Timeline.
2. Click Transition Wizard button on the panel above the Timeline.
3. Select the Pan and Zoom checkbox.
4. Click OK to apply the effect to the clips.

Remove zoom

To remove a pan or zoom effect, right-click a keyframe and select Remove All Keyframes to clear all zoom effects from the clip. To remove
only the selected keyframe, select Remove Keyframe.

Stabilizing video
If you're filming with a handheld camera, it's likely that there might be some unwanted camera shake visible on the video, especially if you
walk or move while filming.

Stabilize a video

1. On the Timeline, select the clip you need to stabilize. To the process shorter, you can cut the video into smaller segments.
2. On the left sidebar, click the More button select Stabilization from the pop-up list.

3. Click Stabilize to open stabilization options. The Stabilization window will open.

4. Set up stabilization with the following parameters:
Accuracy
Shaking

Affects the analysis precision of the video.
Sets how strongly the shaking is visible on the video.

To open the Advanced settings, click the Arrow button and set up stabilization with the following parameters:
Radius

When a video is stabilized, each object is adjusted using the pixels from
the surrounding area. The radius affects how large that area will be. Use a
smaller value for more dynamic videos to avoid mixing objects together and
to preserve more detail.

Smoothing

Limits camera acceleration. Higher values work best for more or less static
videos. Excessive smoothing may limit panning.

Edge Cropping

Eliminates distortion artefacts like blurred areas from the video. There are
several options such as:
• None: the edges will remain as they are. Best results if there is little
shaking on the video.

• Fixed: the video is cropped to one size to cut off some of the edges.
• Adaptive: whenever there is a lot of shaking, the video will zoom in so that
the distorted edges are not shown.
5. Click Stabilize to start processing the video. This may take a while depending on the length of your video and the selected parameters.

6. To save the result, click Apply and you will replace the clip on the Timeline with the stabilized video.
A stabilized copy of the file will be created under "\My Videos\Movavi Video Editor\Stabilized". This copy will be used in the project. If you delete
the stabilized copy, you will lose all the changes made.
If you don’t have enough space to save the stabilized copy, you can free some disk space and try again, or save stabilized copies on another disk:
1. Open the Settings menu and choose Preferences.
2. Switch to the Files tab.
3. Find the "Store stabilized videos in" box and click the button
4. Click OK to accept the changes.
5. Try stabilizing the video again.

on the right to choose another folder on a drive.

Highlight and conceal

This tool will help you to control the focus in the frame, and blur or darken parts of the video.

Apply the Highlight and Conceal tool to the video

1. On the Timeline, select the clip that you want to edit.
2. To open the Highlight and Conceal, click the More button on the left sidebar, and choose Highlight and Conceal in the Video Editing tab.

3. Choose Conceal if you want to hide an object, and Highlight if you want to make an accent on the object.

4. Choose a shape for the mask: you can use a rectangular or an elliptical one.
5. Choose a masking effect: Blur, Matte (black cover-up) or Pixels. Use the options below to set up the mask:
Opacity – makes the mask more transparent (for matte and blur);
Feathering – makes the edges of the mask softer (for matte and blur);
Size – changes the size of the pixels (for pixel masks only);
Outline – adds a white outline around the mask.

6. To change the size and shape of the mask drag its corners in the player, drag by the center of the mask to move it on top of the object.

If you want to cover up or highlight more than one object, click Add Mask at the top of the setting panel to create another mask.

7. Click Apply on the Highlight and Conceal panel to save the changes.

Not available in Video Editor Academic Edition.

Logo

Add your own logo to the entire video with the Logo tool.
1. On the left sidebar, click the More Tools button and select Logo from the pop-up list.

2. Add the image you want to make the logo of your video clicking Add Logo button.

The logo file moves to the Overlay Track and the logo itself is located in the lower right corner of the video on the player.

Chroma key
The Chroma key effect allows you to remove any color from the image or video, leaving the background transparent.

Add Chroma Key

1. Add the video or image clips that you want to use as the foreground and the background.
2. Select the foreground video and move it up, onto the Overlay track.
3. Double-click the foreground video to open Clip Properties.
4. To make the foreground video completely cover the background video, select the Overlap mode.

5. On the left sidebar, click the More button and in the Video Editing list find Chroma Key.

6. Once you open the Chroma Key tool, move your mouse cursor over the player and click on the color that you want to remove. The color
you've picked will become transparent.
Please note that it's better to use green or blue colors, don't choose black, white or grey ones.

Use more settings:
Tolerance
Noise
Edges
Opacity

Set how many similar shades of the selected color should also be removed.
Choose how sharp the object's edges should be.
Choose how thick the object's edges should be.
Set the transparency of the background

7. Finally, click Apply to accept the changes.

Exporting videos

When you're done with your project, you'll need to export it as a media file to be able to play it on the devices. This section will guide you
through the process of exporting your project to a popular video format. If you want to find out more about other ways of saving videos, see
the following guides:
Saving videos for devices
Uploading videos online

Export a video

1. To start saving the video, click the Export button under the player. The export settings window will open.
2. Choose a format for saving the video in.

Some formats allow you to choose between video codecs. If you don't know which format to choose, try using MP4. The MP4 format is
supported by most platforms and operating systems.
At lower resolutions, the file will be significantly smaller, however, the video will lose some quality due to the limitations of digital data
compression.
The GIF format is different from other formats in the list. It allows saving video as a mute animated image, which can then be played in some
image viewing programs or in any web browser.
3. If you want to change the resolution, aspect ratio, or other settings, click the Advanced button to view and edit the project settings. To
save the changes click OK.

4. Name your file and choose a destination folder.

In the 'Save to' field, enter the folder where you would like to store the file. By default, this will be the directory for saving output videos
specified in the preferences. To set a different folder, click the Browse button and choose the folder in the Windows Explorer window, or
enter the path manually into the box. Name your video in the Title field: the project's name will be filled in for you by default.
5. Choose the quality of the video.

If your project is heavy on small details and filters, you can select High or Highest quality to export the finished video with a higher bitrate. This
will increase the output file size but will preserve better quality. For most other projects, Good quality will provide a nice result at a small file size.
6. Click the Start button to begin processing the video file. This may take up to a few minutes.

Export only audio
This section will guide you through exporting just the audio track of your project.

Export an audio

1. Click the Export button in the bottom right-hand corner of the Editor to open the export settings window.

2. Click on the Save Audio File tab in the left part of the Export window.

3. Select the format you'd like to save the audio in.

While MP3 is the most commonplace format, supported by almost all media players and devices, FLAC format allows you to preserve high
audio quality, albeit taking up considerably more disc space. When choosing an output format, it is important to note the quality of the
original files: due to data compression limitations, digital audio cannot be restructured from very low quality files by saving them as FLAC
audio, and vice versa – high quality files may lose some of that quality when saved to MP3 format which is limited to 320 Kbps.
4. Name your file and choose a destination folder.
In the 'Save to' field, enter the folder where you would like to store the file. By default, this will be the directory for saving output videos
specified in the preferences. To set a different folder, click the Browse button and choose the folder in the Windows Explorer window, or
enter the path manually into the box. Name your video in the Title field: the project's name will be filled in for you by default.
5. Click the Start button to begin processing the video file.

Export for devices
This guide will help you export your video project for playing on mobile phones, tablets, and other devices.
1. Click the Export button under the player to open the export settings window.

2. In the left part of the Export window click on the Save for Devices tab.

3. Choose a format.
On this tab you will find a number of different types of devices for which you can choose a format. You can choose between devices running
iOS (iPhone, iPad, iPad mini) or Android, Samsung Galaxy S6 and Galaxy S7, Google Nexus 6 and Google Pixel, as well as Playstation and Xbox
consoles. If your device is not on the list, choose Other.

You can select High or Highest quality to export the finished video with a higher bitrate. This will increase the output file size but will preserve
better quality. For most other projects, Good quality will provide a nice result at a small file size.

4. Name your file and choose a destination folder.
In the 'Save to' field, enter the folder where you would like to store the file. By default, this will be the directory for saving output videos specified
in the preferences. To set a different folder, click the Browse button and choose the folder in the Windows Explorer window, or enter the path
manually into the box. Name your video in the Title field: the project's name will be filled in for you by default.
5. Click the Start button to begin processing the video file. This may take up to a few minutes.

Export for TVs
This guide will help you export your video project for playing on Smart TVs.
1. In the bottom right hand corner of the Editor, click the Export button to open the export settings window.

2. In the left part of the Export window click on the Save for TVs tab.

3. Choose your TV brand and the necessary resolution. If your TV is not on the list, choose Other 1080p TVs or Other 4K TVs.

If your project is heavy on small details and filters, you can select High or Highest quality to export the finished video with a higher bitrate. This
will increase the output file size but will preserve better quality. For most other projects, Good quality will provide a nice result at a small file size.

4. Name your file and choose a destination folder.
In the 'Save to' field, enter the folder where you would like to store the file. By default, this will be the directory for saving output videos specified
in the preferences. To set a different folder, click the Browse button and choose the folder in the Windows Explorer window, or enter the path
manually into the box. Name your video in the Title field: the project's name will be filled in for you by default.
5. Click the Start button to begin processing the video file. This may take up to a few minutes.

Uploading online
After you finish your video, you can share it to YouTube, Vimeo or Google Drive right from the export window.

Upload online

1. Click the Export button to open the exporting window.

2. In the left hand part of the Export window click on the Upload Online tab.

3. On the Upload online tab select the service you would like to upload your videos to: YouTube, Vimeo or Google Drive.

4. Click Sign in. The authentication page will open in your browser.
Sign in to your account and click Allow to let Movavi Video Editor Plus upload videos.

5. In the Export window, open the Resolution list and choose a resolution that suits your project.

Upload to YouTube

1. Fill in the title and description for your video.
2. Add some tags to help users find videos by relevant topics. Separate tags with commas and add a number sign (→) before each one.
3. Choose a category to help viewers find relevant content.
4. Open the Privacy box and choose who you want to see the video:
Private – videos can only be seen by you and the users you choose.
Public – videos can be seen by and shared with anyone.
Unlisted – videos can be seen and shared by anyone with the link.
5. Click Upload to export your video.

Upload to Google Drive

1. Fill in the title for your video.
2. Select a Google Drive folder where you want your video to be uploaded. You can create new folders in your Google Drive storage straight
in the export window.
3. Open the Privacy box and choose who you want to see the video:
Private – videos can only be seen by you and the users you choose.
Unlisted – videos can be seen and shared by anyone with the link.
4. Click Upload to export your video.

Upload to Vimeo

1. Fill in the title and description for the video.
2. Set the level of privacy:
Anyone – any person can watch the video.
Only people I follow – only people you're subscribed to can watch the video.
Only me – nobody, but you can access the video.
3. Select the resolution of the video and add tags.
4. Click Upload to export your video.

Save and upload the video

Before uploading, the video will be saved as a file on your computer.
1. To change where the video file is stored, click Browse and select a folder.
2. Click Upload to begin saving and exporting the video.

Partial project export
Edit and save different parts of the project separately using partial project export.

Adding and editing of the selection

1. To select the part of the project, first add the selection onto the Timeline. To add the selection, place the position marker at the beginning
of the part you want to export, and then choose Add Selection from the Export menu.

2. To edit the size of the part, move the position markers by holding the round part of the marker with the mouse.

Deleting a selection

To delete a selection, right-click on the selected area. In the menu that appears, select Delete Selection.

Export of the selection

1. To export the selection, right-click on the selected area. In the menu that appears, select Export Selection.

2. In the window that opens, enter the project name and select the folder where your project will be saved. To save the selected area, click Start.

Video Editor preferences
To open the preferences:
1. Click the Settings menu

2. Select Preferences.
The Preferences window will open. The preferences are organized into tabs. Click on a tab to open the relevant options.

3. When you're done, click OK to close the window and apply the preferences.
See also:
General preferences
File preferences
Acceleration preferences
Sharing preferences

General preferences
Interface Language – to change the interface language, simply select the necessary language from the list and click OK to apply the
changes.
Automatically check for updates – select this option and you'll be notified whenever a new version is available. Updates within your version
are absolutely free (e.g. 1.0 to 1.1), while new releases are offered with a hefty discount to registered users.
I give consent to send anonymous usage stats to Movavi – check this box to let the program send usage statistics to our development team
and help us to fix all the problems in the program much faster. The data contains no personal information, will not be disclosed to third parties
and will be used for software improvement purposes only.
Use software OpenGL implementation – this option can be useful if your computer doesn't support the necessary OpenGL version and you
see an error message when you start the program.
OpenGL is a software interface that manages graphics output. Usually, OpenGL is handled by your graphics card driver. However, some
graphics cards do not support the necessary version of OpenGL. For these graphics cards, you can use this option to download and install a
software replacement. Installation will run automatically, but you will need an Internet connection to download the files.
If Movavi Video Editor runs without showing an OpenGL error message, this option is not recommended.
Learn more about OpenGL troubleshooting
Play notification sound when exporting is finished – when saving a project as a media file, you'll be notified as soon as the process is
completed.

File preferences
On the Files tab, you can find the options for storing and saving different kinds of files. You can change any of these folders to a different
location.
Save project files to – a folder for saving and opening projects. This folder will also store any autosave files for new projects. You can use the
autosave file to restore your work in case of an error or force close.
Save output videos to – a folder for exporting media files.
Store audio recordings in –a folder for the audio clips that you record in the Editor.
If you delete these audio files, the audio recordings in the project will also be unavailable.
Store stabilized videos in – a folder for a stabilized copy of the original when you stabilize a video.
Don't delete these files while you are working on the project, or you'll have to stabilize the files again.

Changing where the files are stored

Using a different folder might help if you don't have much disk space on your primary drive, or if you want to organize your media files in
another way.
1. Click the button with three dots
next to the folder you want to change.
2. A Windows Explorer dialog box will open. Choose the folder you want to save the files to.

3. Click Select Folder to use this folder.

Sharing preferences

On the Sharing tab of the Preferences window, you can manage your social network accounts for uploading videos.

To sign in:

1. Click Sign In. The authentication page will open in the browser.

2. Sign in to your account.
3. On the next page, allow Movavi Video Editor Plus to upload videos to your account.

4. Return to Movavi Video Editor Plus. Your name will be shown in the Preferences window.

To sign out or use a different account:

Click Sign Out. After this, you will need to sign in again to upload videos.

Acceleration preferences
If your computer is equipped with the necessary hardware, these options can help speed up encoding and decoding of media files, allowing
you to save your movies much faster and enjoy smoother performance.

Enable Intel hardware acceleration

Accelerates video processing by up to 400% when working with H.264 and MPEG-2 video codecs.
This option is only available if your computer is equipped with an Intel processor that supports the Intel HD Graphics™ technology.

Enable NVIDIA hardware acceleration

With this option enabled, your NVIDIA graphics card will be used for processing H.264 and MPEG-2 videos and they will be saved up to 50%
faster.
Because video processing is carried out by the graphics card, your CPU is free for other tasks, ensuring smoother performance in other
programs.
This option is only available if your computer is equipped with an NVIDIA graphics card that supports this technology.

Compatible graphics cards

NVIDIA acceleration supports GeForce, Tesla and Quadro graphics card series. You can find the full list of supported GPUs on NVIDIA®'s
official site: NVIDIA NVENC supported GPUs.

Enable AMD hardware acceleration

With this option enabled, you can use AMD's graphics processing power for converting videos.
Using the graphics card instead of the processor leaves your CPU free for other tasks, and you can use your computer without stuttering
while converting videos.
This option is only available if your computer is equipped with an AMD graphics card that supports this technology.

Fast Track HD Acceleration

Fast Track HD Acceleration provides smooth and fast program running. By enabling HD clips optimization in the Preferences menu you allow
the video editor to create copies of the project files in a smaller size and then use them in the project instead of the original ones. To enable
this feature you need to have free disk space, so the Editor can store and use the copies. Once you finish editing and begin export, high-quality
files will replace all the temporary optimization copies.

Troubleshooting

If acceleration options are unavailable:
Your computer might not have the right hardware.
If you're sure that your hardware meets the requirements, try updating your drivers. You can always find the newest version on the
manufacturer's website: Intel Download Center | NVIDIA Driver Downloads | AMD Download Center

______________________________________________________________________________________________________________________________

Intel HD Graphics is a trademark of Intel Corporation.
NVENC is a trademark of NVIDIA Corporation.
AMD is a trademark of AMD Corporation.

Help and support

Didn't find what you were looking for? Need help with a problem? Have a suggestion? Contact our support team and we'll help you right away.

How to reach us

By email: support@movavi.com
Fill out a support form
We guarantee a response within 3 business days!
If you ran into a problem, please describe it in as much detail as possible; any screenshots, log files, or information
about your system will allow us to help you faster.

Frequently Asked Questions

How to remove the trial watermark
What are the system requirements for using Movavi Video Editor Plus?
What formats does Movavi Video Editor Plus support?
More frequently asked questions

Keyboard shortcuts
Editing video becomes much faster and easier if you learn a few basic keyboard shortcuts, especially if you're using a touchpad. You can find
the list of shortcuts if you open the Help menu and select Keyboard Shortcuts.
Action

Shortcut

Add media files
New project
Open project
Save project

Ctrl+O
Ctrl+N
Ctrl+F
Ctrl+S

Save project as
Split clip
Insert freeze frame
Add keyframe

Ctrl+Shift+S
Ctrl+B
Ctrl+E
Ctrl+T

Full screen view

Alt+Enter

Skip forward 0.5 seconds
Skip backward
0.5 seconds
Next frame

Ctrl+Shift+→
Ctrl+Shift+→

Previous frame

Ctrl+→

Next clip
Previous clip

Shift+→
Shift+→

* For the Animaiton and
Pan and Zoom tools

Ctrl+→

System requirements
Note that Movavi Video Editor Plus may also run on slower machines, however, we cannot guarantee stable performance if the minimum
requirements are not met.

Operating system
Processor

Minimum system requirements
Recommended configuration
Windows® 7/8/10 with latest service packs and patches
Intel®, AMD® or compatible processor, 1.5 Intel, AMD or compatible processor, 2.8 GHz
GHz
and above

Graphics card

Intel® HD Graphics 2000, NVIDIA® GeForce® series 8 and 8M, Quadro FX 4800,
Quadro FX 5600, AMD Radeon™ R600, Mobility Radeon™ HD 4330, Mobility
FirePro™ series, Radeon™ R5 M230 or higher graphics card with up-to-date drivers
Your graphics card must support OpenGL OpenGL 2.1 and above is recommended for
2.0 and above for the program to work
smooth performance
correctly.
1280x768, 32-bit color
1920x1080 or higher

Resolution
RAM
Available disk space

Windows 7, 8, 10 – 2 GB
800 MB for installation
500 MB for ongoing operations

Windows 7,8, 10 – 4 GB
5 GB for ongoing operations
Additional space required to save captured
video, export projects, and process HD video.
Administrator permissions are required for installation
Sound card for audio recording and playback
Intel® hardware acceleration requires a
compatible Intel processor supporting Intel HD
Graphics™ 2nd generation or higher
Learn more

Additional features

Supported formats
Here you can view the list of formats and codecs supported by Movavi Video Editor Plus.
Video Formats
Format
3GPP, 3GP2

(*.3gp, *.3g2)

Codec
H.263
H.264, MPEG-4

ASF – Advanced Streaming Format

MPEG-4, VC-1, WMV V7

AVI – Audio Video Interleave

H.264, MPEG-4

DivX Video

H.263, MJPEG, DivX, Xvid, DV,
Cinepack, Fraps, TechSmith,
Uncompressed
DivX

Flash Video

H.264

(*.asf)
(*.avi)

(*.divx)
(*.flv)

FLV1, H.263, Flash Screen Video
Flash Video
(*.swf)

FLV1
MJPEG

MKV – Matroska

(*.mkv)

H.264, MJPEG
MPEG-4, Theora, DV, Uncompressed

M2TS – MPEG Transport Stream

H.264

MTS – MPEG Transport Steram

MPEG-2, H.264

MPEG

MPEG-1, MPEG-2

MPEG

MPEG-1, MPEG-2, H.264

MPEG-4

MPEG-4, H.264,

(*.m2ts)

(*.ts, *.mts, *.m2t)
(*.mpg)

(*.mpeg, *.mpe, *.m1v, *.mod, *.tod)
(*.mp4)

H.263, MJPEG, ProRes
MPEG-4
MXF – Material eXchange Format

MPEG-4, H.264, H.263, MJPEG,
ProRes
MPEG-2, DV

OGV – Ogg Video

Theora

(*.m4v)
(*.mxf)
(*.ogv)

MPEG-4
MOV – QuickTime

(*.mov)

H.264
MPEG-4, AIC, MJPEG, ProRes,
Sorenson 1/3, PNG

Read

Write

QuickTime

(*.qt)

H.264, MPEG-4, AIC, MJPEG, ProRes,
Sorenson 1/3

RM – RealMedia

Real Video 2/3/4, Cooker

WebM

VP8

(*.rm, *.rmvb)
(*.webm)

VP7, VP9
WMV – Windows Media Video

(*.wmv)

WTV – Windows Recorded TV Show
(*.wtv)

WMV V8
WMV V7, WMV9, WMV 9 Screen,
WMV 9 Advanced profile, MPEG-4,
WMV 9.1 Image V2
H.264, MPEG-2
Audio formats

AAC – Advanced Audio Codec

AAC

AIFF – Audio Interchange File Format
(*.aif, *aiff)
APE – Monkey's Audio

Uncompressed

AU

PCM

FLAC – Free Lossless Audio Codec

FLAC

MP3 – MPEG-1/2 Audio Layer III

MP3

MPEG-4

AAC

OGG – Ogg Audio
(*.ogg)

Vorbis

WAV – Waveform Audio File Format
(*.wav)

PCM

(*.aac)

(*.ape)

(*.au, *.snd)
(*.flac)

(*.mp3)
(*.m4a)

Monkey's Audio

AAC, MP3
WMA – Windows Media Audio

(*.wma)

WMA 9
WMA Pro, WMA Voice
Image formats

BMP, DPX, GIF, JPEG, PGM, PBM, PPM, PAM, PCX, PNG, PTX, TARGA, XBM,
XWD
You can view the full list of supported devices here.

Codec activation

Some video and audio codecs are patented by other companies, and it is required that new users activate the codecs they use to comply
with patent law.

Activate codecs on demand

1. When you open a media file or export your project with one of these codecs, you may see a Codec Activation message.
2. Select the Activate other codecs without asking box to activate all codecs automatically in the future. The codecs will be activated
automatically, but an Internet connection is still necessary.
3. Click Activate to complete the codec activation.

Codec could not be activated

If you see a codec activation error, make sure that you have a working Internet connection. Without Internet, the codecs cannot be activated
even if you've chosen to activate them automatically. After you've restored the network connection, please restart the application.

What kind of data is being sent?

The data we send does not contain any information that can personally identify you. We only receive information about which codecs were
used.

OpenGL troubleshooting

If you see the following message about OpenGL when you open Movavi Video Editor Plus or you've noticed that the player, filters, or
transitions do not work, your computer most likely does not support the necessary version of OpenGL. To run Movavi Video Editor Plus, your
computer needs to support at least OpenGL version 2.0, and version 2.1 is required for smooth performance.

OpenGL is a software interface that manages graphics output. Usually, OpenGL is handled by your graphics card driver. However, some
graphics cards do not support the necessary version of OpenGL. For these graphics cards, you can try the steps below:

Update your graphics card driver

Sometimes, this issue may occur when something is wrong with the graphics card drivers or they are out of date. Download the driver
installation file from the manufacturer's website and install it following the on-screen instructions.
Detailed instructions on updating the driver
It is recommended that you restart the computer after installing driver software. After that, try starting Movavi Video Editor Plus. If you see an
error message again, proceed to the next step.

Try the software OpenGL implementation

If your graphics card still doesn't support OpenGL 2.1 even after updating the driver, you can use a software alternative:
• In the message you see after starting Movavi Video Editor Plus, select the Download and install software OpenGL implementation box.
• Or, in the main Movavi Video Editor Plus window, open the Settings menu and choose Preferences. There, select the Use software OpenGL
implementation option and click OK.

After that, the software OpenGL package will be automatically downloaded and installed. When the installation is finished, restart Movavi
Video Editor Plus.

If these steps haven't helped:

• Check that your computer meets the minimum system requirements. Your graphics card must support at least OpenGL 2.0.
• Contact our support team. Provide your graphics card model and list the steps you've taken to solve the problem.

Updating the graphics card driver

If you encounter an error message asking you to update your graphics drivers, you will need to download a new driver from your graphics
card manufacturer's website and install it on your system. Some graphics card drivers also have a useful utility that notifies you when a
driver update is available and updates the driver automatically. Keeping your graphics card drivers up-to-date will ensure stable performance
of applications and games on your computer.

Find your graphics card manufacturer

1. Right-click your desktop and choose Screen Resolution
2. In the Screen Resolution settings window, click Advanced settings.
3. This will open your graphics card properties. At the top of the window, your graphics card model will be listed under the Adapter Type
section. Note the full name of the graphics card somewhere for later.

Download the new version

Now that you've learned your graphics card manufacturer and model, go to the manufacturer's website and find driver downloads. There,
look for the model or series that you've found earlier and download the driver installation file. Some manufacturers may also offer a utility
that will automatically find the necessary driver.
NVIDIA download center
AMD download center
Intel download center
Warning:

Only download drivers from the official manufacturer's website. Thirdparty websites offering driver downloads may contain malware.

Install driver

Once the file is completely downloaded, run the installation file and follow the onscreen instructions to install the driver on your system. Your
display may blink several times in the process. After the installation has finished, it is advised that you restart the computer.

Updating NVIDIA® Driver

Modern NVIDIA graphics cards come with a special application called NVIDIA GeForce™ Experience that monitors driver updates and allows
you to optimize your computer's graphics performance.
1. Open the NVIDIA GeForce Experience application. It should already be installed on your system. If you cannot find the application, please
try the method above.
NVIDIA download center
2. In the Drivers section, click the Check for updates button to find the latest drivers.
3. When the application has found a newer driver, click the Download driver button. From here, the software will automatically download and
install the necessary driver for your system.

Updating AMD® or ATI® Driver

1. If you have an AMD or ATI graphics card, go to the Driver Download Center on AMD's official website.
AMD Driver Download Center
2. Download the auto detect utility and run it when the download has finished.
Auto Detect Utility
3. The utility will then automatically find your graphics card and help you download and install the right driver for your system.
If the utility fails to find a driver for you, you can manually select your graphics card model and operating system on the Driver Downloads
page and download the driver.
4. After the driver has downloaded, run the installation file and follow the on-screen instructions to install it.
5. After the driver has been installed, it is recommended that you restart your computer.
If none of the above steps have helped, feel free to contact our support team via e-mail or live chat.
If possible, please include the name of your graphics card model, as well as screenshots of any error messages you have encountered. This
will help our support team specialists solve your problem quicker.

Glossary
Here's a list of some terms that you may come across while working with video and audio. You won't need to know all of these to use Movavi
software, but if you want to learn more about the specifics of media file processing, you can start here.

Aspect ratio

A video's aspect ratio is the proportion of its width to height, e.g. 16:9 (read as sixteen-by-nine). Usually, you might encounter the 16:9 or 4:3
aspect ratios, but most recent displays and videos have the 16:9 aspect ratio. You might encounter 4:3 resolutions in some older TV videos.
Here's how different they look:

If you join videos with different aspect ratios, you might see black bars around the edges. Think of a video's frame like a box: if you put a
square peg into a rectangular hole, you might have room left over at the sides. This can happen in your project if you're mixing videos and
photos, or if you're using videos from different sources. This is how it might look if you're adding 4:3 videos to a 16:9 project and vice versa:

To remove the black bars, try using the crop tool, or change the project settings.
Learn more: Removing black bars

Bitrate

Bitrate is a property of digital video and audio files. It means the amount of data in bits contained in each second of the file. Higher bitrate
allows to preserve more detail, but also requires much more disk space for the output file. Bitrate also depends on your video resolution,
because you need much more data to store a large HD video frame compared to a tiny 360p video. If your video has lots of small details or
fast action, you can choose a higher quality when saving the video. The output video will have a larger file size, but you'll be able to see detail
better.

Codec

Video and audio information is processed or encoded to shrink the size of the file. However, your computer needs to have a decoder installed
in order to open the file. There are many different codecs, each compressing video in different ways. Many video formats can store multiple
video formats. For example, you can save a video with the .mp4 extension, but you can use the H.264 or MPEG-4 codecs. If you don't know
what codec works best for you, go for H.264 – it is supported by most players and platforms.

Hint: Don't download codecs from suspicious websites. They may contain malware.

Format

Usually when someone mentions formats, they mean container formats, namely, the way of storing a video or audio file's information inside
a file. You can spot container formats by file extensions. A container format contains video and audio streams, that are be encoded with a
codec. The figure below shows how a standard video file may look like.

Frame rate, FPS

A video's frame rate is the number of frames or still images in each second of the video (also called FPS or frames per second). Most movies
have a frame rate of 24 frames per second, but most cameras and mobile phones shoot video at 30 frames per second. More modern
cameras even allow you to film with 60 FPS and above. If you have a higher frame rate, you can slow down the video to make a slow-motion
effect without making the video look choppy.

*.mepb files

Movavi Video Editor project files are saved with the MEPB extension. You can open the file in the Editor and continue working on your
project. If you upgrade to the Plus version, you will need to save the project file as a MEPX project.

*.mepx files

Movavi Video Editor Plus project files are saved with the MEPX extension. You can open the file in the Editor and continue working on your
project.

Resolution (frame size)

A video's resolution is basically its width and height in pixels. Usually it is written as the width multiplied by height, e.g. "1280x720", or
sometimes you might only see the height listed, e.g. "720p". Usually, videos with high resolution have better quality because there are more
pixels available for storing information. However, if you convert a low-quality video to a higher resolution, it will not instantly look better
because there is nowhere to restore the extra information from, so you will end up with the same quality with a much larger file size. You can
change the resolution of your output video in project settings.

Sample rate
The sample rate affects the quality of digital sound, and defines the maximum frequencies that an audio stream can contain. The default

sample rate is set to 44100 Hz, which exceeds the maximum frequencies of human hearing and is used to record Audio CDs and most music
tracks.

Stream

A video file contains the video and audio information in separate streams, which simply means that their data is stored separately inside the
file. When you play the file, these streams are played simultaneously, just like a stream of water.

Export troubleshooting

Here you will find the most frequent problems with file export and instructions on how to solve them.

Video freezes during exporting

If you see the progress bar freeze at some point, you might be having problems with the drivers.
To solve this problem, try disabling accelerations on the Video Editor Plus menu Settings - Preferences - Acceleration.

Restart the program for its proper functioning.

Unknown export error / Artifacts appear on video

There are several options to solve this common export error. If you faced the export error, try these instructions below.
• Disable acceleration.
1. Find this setting by menu Settings - Preferences - Acceleration.
2. Disable all the ticked accelerations.
• Try the software OpenGL implementation.
1. In the main Movavi Video Editor Plus window, open the Settings menu and choose Preferences - General.
2. Select the Use software OpenGL implementation option and click OK. After that, the software OpenGL package will be automatically
downloaded and installed.
3. When the installation is finished, restart the program.

• Try another video format.
To deal with the export problem try to change the format of your video in the export window and click Start.

Movavi watermark

In order to get rid of the Movavi watermark across your video, you'll have to acquire a license on our website and activate the program with
your activation key. You can learn how to activate the program here.
Once you do that, follow the steps below:
1. Open your project file by clicking File - Open project and select Export.
2. Export the video. The watermark won't be there anymore.
Please note that it is impossible to get rid of the watermark from a video, which you have already saved, but if you have a *.MEPX (or *.MEPB,
*.MEPS) project file, you can re-save it after activating the program and then your video will not contain any watermark.

Video and audio are out of sync

If video and music in your project are out of sync, try to select another video format:
1. Click Export under the player.
2. Select the format of your video (We recommend using MP4).
3. Change other necessary settings.
4. Click Start to export your video.

Creating an Instagram video

Instagram videos have specific format and aspect ratio settings, here you will find a guide for creating Instagram video posts.

Regular Instagram video posts creating

1. Add your video to the Timeline.
2. Click the clip and change its length moving the borders. Change the length of all clips if you want to. Note that your whole video can be
from 3 seconds to 60 seconds.
3. On the player panel find an Aspect ratio button, select the format from the list or set your own proportions by clicking x:y and setting new
ratios in the opened window. For the Instagram videos a minimum aspect ratio is 1.91:1 and a maximum is 4:5.

If the black bars appear, you can remove them using the special filter:
1. Click the Filters tab on the left sidebar.
2. In the Featured filters find Vertical fill.
3. Drag the filter to the clip on the Timeline to blur the edges.

Exporting the video

The result with the filter applied.

Unfortunately, you can’t share your video to Instagram directly from the video editor. Firstly, save your video to the computer and then upload
it to your Instagram account.
1. Click the Export button under the player.
2. Select the MP4 format from the list on the left.
3. Enter the name of your video and click Browse to choose a folder to save your video.

4. Select the quality of the video.
5. Click Start to save the video.

Instagram does not limit file size, but your videos should be under 50MB.

Creating videos for Stories

1. Add a video on the Timeline
2. Set the suitable length, moving the borders of the clip. Videos must be a maximum of 15 seconds long.
On the player panel find an Aspect ratio button, select the format from the list or set your own proportions by clicking x:y and setting new ratios
in the opened window. Videos should have portrait (not landscape) orientation with an aspect ratio of 9:16.

Exporting the video

Unfortunately, you can’t share your video to Instagram directly from the video editor. Firstly, save your video to the computer and then upload
it to your Instagram account.
1. Click the Export button under the player.
2. Select the MP4 format from the list on the left.
3. Enter the name of your video and click Browse to choose a folder to save your video.
4. Select the quality of the video.
5. Click Start to save the video.
Videos should have a minimum frame rate of 30 FPS (frames per second) and a minimum resolution of 720 pixels. The maximum file
size is 4 GB.

Creating videos for Instagram's IGTV

IGTV is an Instagram video format, which can be longer than a regular video post.

How to edit a video to post it on the IGTV

1. Add a video on the Timeline
2. Set the suitable length, moving the borders of the clip. If your account is not very big, you can upload a video lasting from 15 seconds to 10
minutes. If your account is verified and has a tick, your video can be up to 60 minutes long.
3. On the player panel find an Aspect ratio button, select the format from the list or set your own proportions by clicking x:y and setting new
ratios in the opened window. Vertical videos should have an aspect ratio of 9:16, while landscape ones should be 16:9.

Exporting the video

Unfortunately, you can’t share your video to Instagram directly from the video editor. Firstly, save your video to the computer and then upload
it to your Instagram account.
1. Click the Export button under the player.
2. Select the MP4 format from the list on the left.
3. Enter the name of your video and click Browse to choose a folder to save your video.
4. Select the quality of the video.
5. Click Start to save the video.
Maximum sizes: 650 MB for videos that are shorter than 10 minutes; 3.6 GB for videos up to 60 minutes.

